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Getting Started

For more practice navigating the ArcGIS Pro interface, check out our short course: Introduction to ArcGIS Pro

Creating a New Project in ArcGIS Pro

From the Start menu, .launch ArcGIS Pro
When ArcGIS Pro opens, under the New Blank Template section,   the project template.click Map 
In the 'Create a New Project' window, for Name,   " ".type PlayMapping
For Location,   the   button to the right.click Browse...
In the 'Select a folder to store the project.' window,   in the left column and     in the right column and    .click Computer click Desktop click OK
In the 'Create a New Project' Window, click OK.

 the   application window.Maximize ArcGIS Pro

Editing the New Map 

A map is a project item used to display and work with geographic data in two dimensions. The first step to visualizing any data is creating a new map. The 
Ribbon runs horizontally across the top of the ArcGIS Pro interface. Tools (buttons) are organized into tabs along the Ribbon.
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This guide was created by the staff of the GIS/Data Center at Rice University for the custom course - ESCI 545 Hydrocarbon Systems Analysis 
- and is to be used for individual educational purposes only. The steps outlined in this guide require access to ArcGIS Pro software and data 
that is available both online and at Fondren Library.

The following text styles are used throughout the guide:

Explanatory text appears in a regular font.

Instruction text is numbered.
Required actions are underlined.
Objects of the actions are in bold.

Folder and file names are in italics.

Names of Programs, Windows, Panes, Views, or Buttons are Capitalized.

'Names of windows or entry fields are in single quotation marks.'

"Text to be typed appears in double quotation marks."

Presentation Slides

PlayMapping.zip

 Use GIS workflows to collate and synthesize datasets to create geologic and play elements maps that will be used in Course Objective:
petroleum system and risk analysis of potential opportunities and plays.

https://wiki.rice.edu/confluence/display/GDCGUIDES/Introduction+to+ArcGIS+Pro
https://wiki.rice.edu/confluence/download/attachments/40736471/ESCI545_Presentation.pdf?version=1&modificationDate=1599784205977&api=v2
https://wiki.rice.edu/confluence/download/attachments/40736471/PlayMapping.zip?version=1&modificationDate=1599852263965&api=v2
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You will notice that a new Map View opens in the main section of ArcGIS Pro. The panel on the left side of ArcGIS Pro is called the Contents pane. The 
Contents pane displays the default   title and automatically adds the   basemap layer to the map.Map Topographic

The panel on the right side of ArcGIS Pro is called the Catalog pane. The Maps section is at the top of the Project tab within the Catalog pane.

In the Catalog pane,   to expand the   section.click the arrow Maps

Notice that there is a single map there, named . Since most projects will have multiple maps, it is a good idea to name your maps with more Map
descriptive titles.

In the Catalog pane, under the Maps section,     and    .right-click Map select Rename
 " " and    .Type GISWorkshop hit Enter

Saving a Project

Any time you create a new project item (such as a map or a layout), spend time adjusting the symbology of your map layers, or are preparing to run a tool, 
it is a good idea to save your project.

Above the Ribbon, on the Quick Access toolbar,   the   button.click Save

Data Management

For more practice with Data Management, check out our short course: Introduction to GIS Data Management

Download Workshop Data  

Click Workshop_Data.zip above to download the tutorial data. Make a note where this file is saved on your personal computer. 
Open your   folder.Downloads
Right-click   and  .Workshop_Data.zip select Extract All...
In the Extract Compressed (Zipped) Folders window,  the  into the   folder.accept default location Downloads
Click  .Extract

Browsing Existing Data

In the Catalog pane,   to expand the   section.click the arrow Databases

Workshop Data Download

Workshop_Data.zip

https://wiki.rice.edu/confluence/display/GDCGUIDES/Introduction+to+GIS+Data+Management
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 to expand the   geodatabase. You will notice there is no data in the project geodatabase. Over the next few Click the arrow PlayMapping.gdb
sections, we will transfer and generate data to this project geodatabase.
In the Catalog pane,   to expand the   section. Again, notice there is no data in the folder, just the default PlayMapping folder click the arrow Folders
created with this project. 

Connecting to a Folder

In the Catalog pane,     and    .right-click Folders select Add Folder Connection
Navigate to your personal downloads folder and   on click . Downloads
Click  .OK
In the Catalog pane,  and then  the  folder.expand Downloads expand Workshop_Data 
Your  folder should look like the below image.Workshop_Data

Expand the  so you can see the  feature class. SpatialJoinData.gdb geologic_features_poly

Importing Data to Project Geodatabase and Project Folder

In the Catalog pane,   the   from the   and   it click-and-hold  geodatabase feature classgeologic_features_poly SpatialJoinData.gdb drag-and-drop
up into the  . A progress bar will appear that reads 'Copying...' Once it is complete, you will see a copy of PlayMapping.gdb geologic_features_poly
 inside the PlayMapping.gdb.
In the Catalog pane,  the  from the  folder and   it up into the  . click-and-hold  HST.jpg Workshop_Data drag-and-drop PlayMapping project folder
In the Catalog pane,   the  from the click-and-hold  IGOR_masterlist excel file folder and   it up into the Workshop_Data  drag-and-drop PlayMapping

.project folder
In the Catalog pane, in the Folders section,   on   and  .right-click Downloads select Remove
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Your PlayMapping project folder should look like the below image.

Adding Data to a Map

For more practice with Coordinate Systems, check out our short course: Introduction to Coordinate Systems and Projections

The map takes on the projection of the first data layer added. If a JPG is added first, then the map projection would be undefined (as the 
projection for a JPG is undefined). To define the map's coordinate system, in the Contents pane on the left,  the  map and right-click GISWorkshop

 to . navigate Properties > Coordinate Systems > Geographic Coordinate Systems > North America > USA and Territories > NAD 1927
  in the Properties window.Click OK

In the Catalog pane,  the   raster and    .right-click HST.jpg select Add To Current Map
An alternative method of adding data to a map is to   the item and   it into the Map View.click-and-hold drag-and-drop

Georeferencing

Georeferencing is the process of defining the location of raster data using map coordinates which allows it to be viewed, queried, and analyzed with your 
other geographic data. For more practice with Georeferencing, check out our short course:  . Mapping Imagery For more information on Georefencing in 
ArcGIS Pro, check out this help resource: Georeferencing

When Georeferencing, as well as later editing we will do in this course,   to pan across the screen when you are click and hold the mouse scroll wheel
currently in an editing session.

In the Contents pane,   then  .right-click HST.jpg click Zoom to Layer
In the Contents pane,   so that is highlighted in light blue. From the Ribbon,  the  tab and then  the bclick HST.jpg click  Imagery click  Georeference 
utton. 

 .Click Add Control Points

  of the HST JPG. This selects this point on the JPG to georeference. If you need to zoom in and pan around to see Left-click the top left corner
the corners of the JPG, you can move the mouse scroll wheel to zoom and click and drag the mouse scroll wheel to pan.

 anywhere on the map. This opens up a  pop-up box, in which you can manually enter X and Y values.Right-click Target Coordinates

https://wiki.rice.edu/confluence/display/GDCGUIDES/Introduction+to+Coordinate+Systems+and+Projections
https://wiki.rice.edu/confluence/display/GDCGUIDES/Mapping+Imagery
https://pro.arcgis.com/en/pro-app/help/data/imagery/georeferencing-tools.htm
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   and  . The x-value is the West coordinate and it is negative because we are in the Western Hemisphere. The y-Type X : -104.5, Y : 33 click OK
value is the North coordinate.

In the Contents pane,   and  .right-click HST click Zoom to Layer
Repeat steps 5-8 for the bottom right corner of HST, but  . type X : -103.5, Y : 32
Repeat steps 5-8 for the bottom left corner of HST but  .type X : -104.5, Y : 32
Repeat steps 5-8 for the top right corner but  . type X : -103.5, Y : 33
Your georeferenced HST should look like this:

From the Georeferencing tab,  . click Save

Then  .click Close Georeference

Above the Ribbon, on the Quick Access toolbar, click the Save button.

Digitizing Features

For more practice with Digitizing Features, check out our short course:  . Creating Vector Data For more information on digitizing features in ArcGIS Pro, 
check out this help resource: Creating Features

In the Catalog pane,  the  section.expand Databases
  and  . Right-click PlayMapping.gdb select New > Feature Class

 it " . Name HSTPoints"

https://wiki.rice.edu/confluence/display/GDCGUIDES/Creating+Vector+Data
https://pro.arcgis.com/en/pro-app/help/editing/introduction-to-creating-2d-and-3d-features.htm
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Under the Feature Class Type drop-down box,  .select Point

  twice. Click Next
In the Spatial Reference section, under the Layers section, select the NAD 1927 projection. 

 twice again.Click Next
 Click Finish.

If the new feature class did not automatically iadd to your map: From the Catalog pane in the Databases section,  .   expand PlayMappping.gdb Rig
   and  . ht-click HSTPoints select Add to Current Map

In the Contents pane,   and  . right-click HSTPoints select Attribute Table
From the top of the attribute table, next to the   section,   the button. Field: click Add 

A new Fields view table appears. In the third row of the Field Name column,  " . type Thickness"
Change the Data Type to Short Integer by    box then  . clicking the drop-down selecting Short

From the Ribbon, in the Fields tab,  the  button.click Save
Close the Fields view table by  the  at the top right corner of . clicking X Fields: HSTPoints
From the Ribbon,  the  tab.select Edit
From the Edit tab, in the Features group,  . click Create A new pane, Create Features, opens on the right side of the screen.
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From the Create Features pane,    and  the  button (first in list).click HSTPoints select Point

 
In the Map View,  to  on the topmost left point displayed on the . click add a point HST.jpg
In the Attribute Table, a new row has been generated for this newly created point.  in the  for this row and  " ". Click Thickness cell type 7
Repeat steps 19 and 20 for all points on .HST.jpg
From the Edit tab, in the Manage Edits group,  . click Save

  for the 'Save all edits?' pop-up window. Click Yes
In the Edit tab,  to the ection and  the  button to unselect any points.navigate Selection s click Clear

 the  pane.Close Create Features
 the . Close Attribute Table

Above the Ribbon, on the Quick Access toolbar, click the Save button.

Interpolation

This sections steps through how to interpolate a raster surface from points using a natural neighbor technique. For more practice with Interpolation, check 
out our short course:  . For more information on Natural Neighbor Interpolation in ArcGIS Pro, check out this tool Data Interpolation and Extraction
reference: Natural Neighbor (Spatial Analyst)

From the Ribbon,  the  tab.click Analysis
From the Analysis tab, in the Geoprocessing group,  the  button. A new pane, Geoprocessing, will appear on the right side of the click Tools
screen. 

In the Geoprocessing pane,   into the 'Find Tools' search bar. type "Natural Neighbor" 
 .Select Natural Neighbor (Spatial Analyst Tools)

Under Input point features,  the drop-down menu and  .click select HSTPoints
Under Z value field,  .choose Thickness
Under Output raster,  the name to .change HST_Interp_NN
When your Geoprocessing pane looks like this,   click Run.

https://wiki.rice.edu/confluence/display/GDCGUIDES/Data+Interpolation+and+Extraction
http://https//pro.arcgis.com/en/pro-app/tool-reference/spatial-analyst/natural-neighbor.htm
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Your output raster should look like this:

Above the Ribbon, on the Quick Access toolbar, click the Save button.

Symbology

For more practice with Symbology, check out our short course:  . Introduction to ArcGIS Pro For more information on Symbology in ArcGIS Pro, check out 
this help resource: Symbology 

In the Contents pane,   and  . right-click HST_Interp_NN select Symbology A new pane, Symbology, will open up on the right side of the screen. Fr
om here you can change the symbology settings, which affects how the  raster is displayed on the map. HST_Interp_NN Stretched symbology 
displays continuous raster cell values across a gradual ramp of colors. Classified symbology displays thematic rasters by grouping cell values into 
classes. 
In the Symbology pane,   from the Primary symbology drop down menu. To change the number or classes, use the drop-down choose Classify
box under Classes. To manually alter the class intervals, double-click the upper values box you would like to edit and enter the new values. To 
change the color, use the drop-down options under Color Scheme.
In the Symbology pane,   from the Primary symbology drop down menu. choose Stretch To change the color, use the drop-down options under 
Color Scheme.
Above the Ribbon, on the Quick Access toolbar, click the Save button.

Contour

This section steps through how to generate contour lines by joining points with the same elevation from a raster dataset. For more information on the 
Contour tool in ArcGIS Pro, check out this tool reference: Contour

From the Ribbon,   the   tab.click Analysis
From the Analysis tab, in the Geoprocessing group,   the   button. The Geoprocessing pane will appear on the right side of the screen. click Tools
In the Geoprocessing pane,    . type Contour

  .Select Contour (Spatial Analyst Tools)
From the Input raster drop-down menu,  .select HST_Interp_NN
Under Output polyline features,   .type "HST_Interp_NN_Contour"
Under Contour interval   .type "10"

 the  contour as 0. Leave Base
 the  as 1. If you were using a different thickness than feet, you would want to input the conversion factor here.Leave Z factor

https://wiki.rice.edu/confluence/display/GDCGUIDES/Introduction+to+ArcGIS+Pro
https://pro.arcgis.com/en/pro-app/help/mapping/layer-properties/symbolize-feature-layers.htm
https://pro.arcgis.com/en/pro-app/help/data/imagery/contour-function.htm
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When your Geoprocessing panel looks like this,  .click Run

Above the Ribbon, on the Quick Access toolbar, click the Save button.

Importing Excel Data

For more practice with displaying XY data, check out our short course:  . For more information on working with Mapping Locations Using XY Coordinates
Excel in ArcGIS Pro, check out this help resource: Work with Excel in ArcGIS Pro

From the Ribbon,   the   tab.click Analysis
From the Analysis tab, in the Geoprocessing group,   the   button. The Geoprocessing pane will appear on the right side of the screen. click Tools
In the Geoprocessing pane,    . type Excel to Table

  .Select Excel to Table (Conversion Tools)
For Input Excel File,  the  button.click Browse
On the left side of the Browse window,  .click Folders
On the right side of the Browse window,  the  folder and  double click PlayMapping choose IGOR_masterlist
Under Output Table,   the table  .name GIS_Wells
From the Sheet drop down,  the  sheet. This ensures that the  sheet will be the data converted from an excel table to choose GIS_Wells GIS_Wells
a geodatabase table. 
When your Geoprocessing pane looks like this,  .click Run

In the Contents pane,  the  table and  .right-click GIS_Wells select Display XY Data
 the layer Name "GIS_Wells_Pts". 

Check that the X Field states "longitude" and the Y Field states "latitude". 
For Coordinate System, use the dropdown menu to  . The coordinate system should now be select Current Map [GISWorkshop]
GCS_North_American_1927. 

https://wiki.rice.edu/confluence/display/GDCGUIDES/Mapping+Locations+Using+XY+Coordinates
https://pro.arcgis.com/en/pro-app/help/data/excel/work-with-excel-in-arcgis-pro.htm
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When your Geoprocessing pane looks like this,  .click Run

In the Contents pane,  on  and  .rick-click GIS_Wells_Pts select Zoom to Layer
In the Contents pane,   and  . right-click GIS_Wells_Pts select Label
Right-click GIS_Wells_Pts and  . select Label Properties A new pane, Label Class, will open on the right side of the screen.
Under the Expression box, clear the current input. 
Under the Fields box,  . The Expression box should now read  .double click api_number $feature.api_number
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When your Label Class pane looks like this, .click Apply

Above the Ribbon, on the Quick Access toolbar, click the Save button.

Spatial Join

This section steps through how to joins attributes from one feature to another based on a spatial relationship. For more practice with Spatial Joins, check 
out our short course:  . Introduction to Geoprocessing For more information on Spatial Join in ArcGIS Pro, check out this tool reference: Spatial Join

In the Catalog pane, .expand PlayMapping.gdb
Right-click on  and  . geologic_features_poly select Add to Current Map
In the Contents pane,  on  and  . right-click geologic_features_poly select Symbology
From the Symbology pane, use the dropdown menu to  . select Unique Values

 the Field 1 selection to . Change FEATURE
From the Color Scheme drop-down,  the color scheme that you would like. select
From the Ribbon,   the   tab.click Analysis
From the Analysis tab, in the Geoprocessing group,   the   button. The Geoprocessing pane will appear on the right side of the screen. click Tools
In the Geoprocessing pane,    . type Spatial Join

https://wiki.rice.edu/confluence/display/GDCGUIDES/Introduction+to+Geoprocessing
https://pro.arcgis.com/en/pro-app/tool-reference/analysis/spatial-join.htm
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  .Select Spatial Join (Analysis Tools)
Under Target Features,  .select GIS_Wells_Pts
Under Join Features,  . select geologic_features_poly

 the Output Feature Class as . Rename GIS_Wells_SpatialJoin
 the default setting of  for the Join Operation.Retain Join_one_to_one
 . Retain all other default settings

When your Geoprocessing pane looks like this, click Run.

In the Contents pane,  on  and  .right-click GIS_Wells_Pts select Remove
In the Contents pane,  on  and  it  . double-click GIS_Wells_SpatialJoin rename GIS_Wells
Above the Ribbon, on the Quick Access toolbar, click the Save button.
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